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Send us a Topic or Tip


Have a suggestion for the blog? Perhaps a topic you'd like us to write about? If so, we'd love to hear from you! Fancy yourself a writer and have a tech tip, handy computer trick, or "how to" to share? Let us know what you'd like to contribute!





Email:

Name (Optional):

Post Title (Optional):



Suggestion:










 

Thanks for reaching out!
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> Tech Tips> Reduce PDF File Size and Control Quality for FREE With Standard macOS ToolsReduce PDF File Size and Control Quality for FREE With Standard macOS Tools
Rocket Yard ContributorTech Tips
posted on Jul. 24, 2020September 9, 2020









by Erik van der Neut




You have a high-resolution multi-page PDF document, but its file size is too large to share easily. How do you reduce the file size before you send it off?









Resizing PDFs




There are a variety of options for reducing the file size of your PDF file on Mac. Third-party apps specifically designed for this job are plentiful and web sites can do it for you for free. But, if you aren’t too keen on installing and paying for additional software or uploading your document to some web site, there is a way to easily do this on your Mac with tools that come standard in macOS.




As mentioned in an earlier Rocket Yard post, in the Preview app on the Mac, you can select “File > Export…” and then choose the Reduce File Size option in the Quartz Filter dropdown in order to save your file with a much smaller file size:









The problem here is that this standard option does not give you control over how much to lower the quality in order to reduce the file size, and this standard option will leave you with a very small file of very poor image quality.




ColorSync




This is where the Mac standard ColorSync Utility can help you out. It is here that this Reduce File Size filter option is specified. You can inspect it and copy it and adjust the settings to create additional filter options. 




By doing this, you’ll give yourself more filter options for the Preview export:




1. From “Applications > Utilities,” open the ColorSync Utility




2. Go to the Filters tab and find the Reduce File Size option in the filters list




3. Expand the filter by clicking the arrows on the left, so that you can see the details. The default option to “Constrain Size” is set to a max of 512 pixels, which explains why you are getting poor quality PDFs when reducing the file size in Preview. This setting is not just good enough for retaining any detail.









4. Click on the down arrow on the right of this filter and choose Duplicate Filter.









This will create a filter named Reduce File Size Copy at the bottom of the list.




5. On the duplicated filter, select the arrow on the left to open it up and change its name and settings. To change the name, double click it. To create some different filter options, create a few with different Resolution and Quality settings.




For example, I have the following custom filters set up:




	Reduce File Size (100 dpi, low quality)
	Reduce File Size (100 dpi, high quality)
	Reduce File Size (150 dpi, high quality)










As soon as you create your custom filters, they will appear in the Quartz Filter dropdown of Preview’s “File > Export…” menu as well.









Super handy. No need for any 3rd party software, and no need to upload your documents to some web site to do this for you. And, you have a lot of control over how to reduce the size of your documents.




Hope this helps someone,




Cheers!




Erik is a User Interface designer and iOS developer with a Masters in Cognitive Science and Engineering. He is also a lifelong Prince fan, and plays drums in a classic rock cover band in Brisbane, Australia.




Do you have a helpful tip or trick you’d like to share with other Rocket Yard readers? If so, let us know at rocketyard@macsales.com!





Other Topics You Might Like:

		
					How to Save a File as a PDF Using macOS Preview in 3 Easy Steps
							How to Reduce the File Size of a PDF on a Mac
							Rocket Yard Guide: Five Great Yet Forgotten Mac Tips
							Friday Five: Memes, Editing, Signing and More with the OS X Preview App
				







the authorRocket Yard Contributor
Would you like to contribute? If you have a tip, trick, or piece of knowledge that you would like to share with other readers, send your submissions to rocketyard@macsales.com!
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												Leteto says:					


					
						September 6, 2022 at 12:44 am					


									

				
					THANK YOU !!!!!

I looking for this for so many years ….

				


				Reply
			
		
	
			
				
					
												AB says:					


					
						June 9, 2022 at 4:06 am					


									

				
					Absolutely great. I was looking for that for quite some time.

Tip for any interested, I prefer slightly higher resolution (more dpi’s, like 200 or 300) and poorer JPG resolution (~1/4 quality).

Best, A.

				


				Reply
			
		
	
			
				
					
												Roxanne says:					


					
						June 6, 2022 at 3:36 pm					


									

				
					Brilliant! Thank you so very much. Worked beautifully!

				


				Reply
			
		
	
			
				
					
												Penny says:					


					
						May 2, 2022 at 2:19 am					


									

				
					Thank you Erik van der Neut!

Old school girl is going to give it a try cause it drives me nuts having my dox exposed on every Tom, Dick & Harry site! Appreciate :)

It worked! The true test will be friends opinion when they open file on their PC. Glad I could send it! Appreciate Erik :)

				


				Reply
			
		
	
			
				
					
												Vigneshwaran Murugesan says:					


					
						April 12, 2022 at 2:01 pm					


									

				
					I cannot thank you enough. Genius way to customize pdf file dpi.

				


				Reply
			
		
	
			
				
					
												Vinny says:					


					
						February 23, 2022 at 10:17 pm					


									

				
					Thank you for explaining option to improve quality of ‘Reduce File Size’ option.

				


				Reply
			
		
	
			
				
					
												Dami says:					


					
						December 16, 2021 at 5:00 am					


									

				
					This is great that operating system has a feature like this built-in so there is no need to install any third party software for this purpose.

				


				Reply
			
		
	
			
				
					
												Cory says:					


					
						November 27, 2021 at 12:29 am					


									

				
					Thanks! That was super helpful!

				


				Reply
			
		
	
			
				
					
												Miriam says:					


					
						November 8, 2021 at 5:11 am					


									

				
					Thank you, Erik! What a drama but your article provided a lovely, clear, simple solution. Bless you!

				


				Reply
			
		
	
			
				
					
												Math-e-Cooperativa says:					


					
						August 23, 2021 at 6:22 am					


									

				
					Your advice seems to be great – in fact, I was thrilled to find out! – but…

Preview seems to crash every time I try to use my alternative choice of “reducing the file size”…!

Does anybody else, or You, have the same problem?

				


				Reply
			
		
	
			
				
					
												Shaun and Bene says:					


					
						June 12, 2021 at 2:05 pm					


									

				
					Thank you for changing our lives

				


				Reply
			
		
	
			
				
					
												Shinhoo says:					


					
						April 16, 2021 at 11:19 pm					


									

				
					Thank you so much for this post.

This really helps!

				


				Reply
			
		
	
			
				
					
												Anonymous says:					


					
						February 9, 2021 at 8:48 pm					


									

				
					I have Yosemite, and it didn’t quite work for me either. The reduce file 150 dpi filter did not show up in the menu like it was supposed to. I found a work around, open the .pdf file in ColorSync Utility instead of Preview app and the 150 dpi reducer shows up in that pull down menu. Just apply it to the file and it works.

				


				Reply
			
		
	
			
				
					
												eric says:					


					
						February 1, 2021 at 7:14 pm					


									

				
					Really helpful. I am not very techy and I did it! Just one thing is that my Color Sync does not look like yours. Maybe an older version but it worked. Thanks so much, now even angrier at Adobe Acrobat doing everything they can to extract money from me.

				


				Reply
			
		
	
			
				
					
												Teddy says:					


					
						January 28, 2021 at 4:20 pm					


									

				
					I’m a complete noob but found this very clear and useful. Thanks!

				


				Reply
			
		
	
			
				
					
												Prof Albertson says:					


					
						January 3, 2021 at 11:11 am					


									

				
					Hi Erik,

I am writing to say ‘Thank You’ for your excellent Tutorial on reducing file size. I am a university professor who needs to scan handwritten charts for my students. The average file size is 6MB, and once I applied your instructions on utilizing the ColorSync utility, my file size is down to a reasonable 250KB.  Many thanks, Regards Prof JA
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												Philip says:					


					
						December 27, 2020 at 1:48 pm					


									

				
					I’m not sure I get this to work on High Sierra. If I make changes to a duplicated filter, or if I duplicate the size reduction filter again and make changes to create a second version, Preview will nevertheless produce identical results to the first version I created. Anyone else experiencing this?
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												DANY KIM says:					


					
						October 14, 2020 at 2:24 am					


									

				
					Thank you so much! you are my angel in disguise :) It worked for me!!

				


				Reply
			
		
	
			
				
					
												William says:					


					
						August 4, 2020 at 2:25 pm					


									

				
					Fantastic! Very clear instructions and extremely useful to me… And how obscure to begin with to use the Quartz filter, and doubly obscure to use Color Sync to modify it.. I appreciate people like you unmasking these tools….
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												Mike R says:					


					
						July 30, 2020 at 5:22 pm					


									

				
					If you use Adobe Acrobat Pro, you can of course reduce size under: > Document > Reduce File Size…

  And you can control the resulting image resolution under: > Advanced > PDF Optimizer… > Images
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												smayer97 says:					


					
						July 28, 2020 at 1:40 pm					


									

				
					Another simple quick-and-dirty trick that also works is simply printing a PDF file to a PDF file.

This seems to strip extra file size consuming features from the original file to create a print version of the file, thereby also making it smaller.

The only thing lacking from this trick is control over the results, but it does work a lot of the time, especially your own documents previously scanned to PDF.
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												Jim E says:					


					
						July 27, 2020 at 11:00 am					


									

				
					Thank you! Very timely and helpful!

				


				Reply
			
		
	
			
				
					
												William Owen says:					


					
						July 26, 2020 at 9:04 am					


									

				
					do you have a catalog or lit of items for sale with prices
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												Mark Chaffee says:					


					
						July 27, 2020 at 9:08 am					


									

				
					You can go directly to MacSales.com to see all of OWC’s products (and Apple gear we carry). Also, feel free to call Customer Support at 1-800-275-4576 in the US, or +1-815-338-8685 internationally with any questions you may have!
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												William one says:					


					
						July 26, 2020 at 8:53 am					


									

				
					these pages were very helpful  thanks
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												Lee smith says:					


					
						July 25, 2020 at 1:55 pm					


									

				
					Excellent article on compressing PDF files but leaves a little unknown by some of us (me). What are the advantages/disadvantages and differences of the three options you selected for your duplicate filters. I understand how but now want to know why?

Keep up the good work and really good info.

				


				Reply
			
		
	
			
				
					
												Bob Bradley says:					


					
						July 25, 2020 at 1:55 pm					


									

				
					When I did this, setting an option of 100 dpi, low quality, it didn’t seem to take. Because if I opened ColorSync again, the “100 dpi, low quality” was reset to 100 dpi, high quality.
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												Allan Der says:					


					
						July 25, 2020 at 10:54 am					


									

				
					Thanks, really works well. I never would have know that the Color Sync utility controlled the exports in Preview.

BTW, “DPI” (dots per inch) referring to the halftone process used in printing on paper. “PPI” (pixels per inch) refers digital images made up of pixels.
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												Greg Koch says:					


					
						July 25, 2020 at 7:52 am					


									

				
					I am really looking forward to trying this out.  From my 36+ years working in the manned spaceflight sector, I have a lot of documents and pictures scanned in as hi-res PDFs that I would place on my website.
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												Joel says:					


					
						July 28, 2020 at 5:40 pm					


									

				
					Greg, this sounds very exciting!

I have used PDF Expert by Readdle for reducing hi-res PDFs to a reasonable size for around 4 years now. Its auto reduce file size is the best I’ve found, and I have tried many over the years. Moments ago I was testing a 75MB PDF with text and images and was able to reduce it to 5MB with minimal impact on quality using the “High Quality” setting (93% reduction). The “Medium Quality” file (96% reduction)  was 2.5MB and was still very good.

I’ve previously tried the method used in this article, but must admit I did not try it just now in Catalina. Previous experiments in macOS were quite disappointing. I’ve destroyed all quality using built in filters in Preview with no discernible reduction in file size. That lead me to finally finding this app.

Use a copy of the file as PDF Expert does alter the file you are reducing. Believe the warning it gives that your original full quality version will be no more if this one is your only version.

One other thing I’d say is to make sure you have backups of the original files. There was nothing worse than finding a reduced version was too reduced and that it is now the only version of the file I have. This has happened to me several times, fortunately while experimenting and not with actually valuable archival PDFs.

Good luck (and I hope I didn’t trample to much on this article)

Ciao. Joel.
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												Sebastian says:					


					
						January 27, 2023 at 7:43 am					


									

				
					Joel, you spoke out of my heard, thanks! I am working with quartz since some years but have never really understood which option effects what precisely. Today I lost >2 hours trying to find a setting to reduce a 300 dpi pdf that was originally offset printed. I didn’t manage. With that PDF Expert 7 days trial I shrank it from 160 to 31MB maintaining a real good quality!

Actually I want it to be “only” 100 MB – how can I alter the reduction settings in PDF Expert?!

All the best, Sebastian
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						July 25, 2020 at 6:18 am					


									

				
					Which procedure, including Adobe Acrobat Pro DC reduce most the size of PDF files? Which percentages? Thanks!
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												smayer97 says:					


					
						July 24, 2020 at 4:41 pm					


									

				
					very nice yo know! Thx
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												Bill W says:					


					
						July 24, 2020 at 1:38 pm					


									

				
					As an advanced user, I did not know this and love this tip. Thank you!
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